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Ch -1 

Generations of computers 

 Keywords 
 

 Vacuum tube: A device that was use in the first-generation computers to amplify electronic 

signals. 

 Punched Cards: A piece of stiff paper that was used to contain digital information in the first 

generation computers. 

 Machine language: A programming language that a computer understands directly. 

 Transistor: A device that was used in the second generation computers to amplify electronic 

signals 

 Integrated circuit: A device that was use in place of transistors in the third generation 

computers. 

 High-level language: A programming language that is much closer to human language. 

 Microprocessor: A device that was use in place of transistors in the fourth generation computers. 

 Artificial intelligence: A technology that enables a machine to think take decision like human 

beings. 

EXERCISE CORNER 

A. Choose the correct option. 

1. Vacuum tubes were signals used to: 

a) Amplify the signals               b) to input data                            c) to output data 

 

2. Which one is an example of the first-generation computer? 

a) ENIAC                                   b) UNIVAC                                   c) IBM 360 

 

3. Which of the following were used to input the data in the third-generation computers? 

a) Chips                                      b) punched cards                          c) keyboards 

 

4. Transistors were used to: 

a) First generation computers 

b) Second generation computers 

c) Third generation computers 

 

5. In which generation of computers were integrated circuits used? 

a) Fifth generation                      b) Fourth generation                 c) Third generation 

 

B. Fill in the blanks. 

Heat   FORTAN   artificial    intelligence   large room    LSI       VLSI  



 

 

1. The vacuum tubes produced a large numbers amount of heat. 

2. First generation computers required a large room for the installation. 

3. LSI and VLSI circuits were used in fourth generation computers. 

4.Fortran is an example of a high-level language. 

5. Fifth generation computers are based on artificial intelligence. 

C. State ‘True’ and ‘False’. 

1. The concept of punched cards was use in the third-generation computer.                        F 

2. In the fourth generation computers, transistors were used in place of vacuum tubes.     F 

3. Microprocessor is a combination of LSI and VLSI circuits.                                               T  

4. IC smaller in size and more reliable than vacuum tubes and transistors.                         T 

5. Sac State 8008 was the world’s first complete microcomputer.                                          T 

D. Match the columns. 

                Column A                                                                        Column B 

1. Machine language                                               a. Fifth generation 

2. Magnetic tapes                                                     b. First generation 

3. Optical fiber technology                                     c. Super computer 

4. Cray-1                                                                   d. Fourth computer 

5. Mouse & handheld device                                   e. Second generation 

E. Short answers questions. 

1. What was the use to punched cards in first generation of computers? 

  Ans: -The punched cards were used to feed the data into the first generation computers. 

2. What are vacuum tubes? 

   Ans: -It is a sealed glass tube from which all the gases are removed. It allows the free passage of 

electric current . 

3. Write any two characteristics of fourth generation of computers. 

Ans:-      a. IBM 1620                                  b. IBM 7094 

4. Who developed IC? 



 

Ans:-Jack Kilby, Robert Noyce 

5. Write any two characteristics of fourth generation computers. 

Ans:-i. GUI based OS were used                       ii. High-level languages were used. 

F. Long answer questions. 

1. What do you understand by the ‘generation’? 

Ans: -The term generation refers to a step in technology. In other words, generation provides a 

framework for computer industry to distinguish between various technologies. 

2. Describe any four characteristics of third generation computers. 

Ans: -The third-generation computers were smaller in size, reliable, efficient, less expensive, and 

faster than previous generations 

3. What is AI? 

    Ans:-AI (Artificial Intelligence) is a technology that enables a machine to think and take decision 

like human beings. 

4. Distinguish between first generation and second-generation computers. 

Ans:         Generation            Circuitry                    Language                Example 

 

          First                  Vacuum tubes      Machine Language       UNIVAC,             

 

 

          Second              Transistors          Assembly and some       IBM 1620, 

                                                                      high level languages       IBM 7094 

                                                                       such as FORTRAN,      IBM 701 

                                                                      COBOL, etc. 
 

 

 

 

 

 

 

 

 

 



 

CH -2 

          COMPUTER SOFTWARE 

 Keywords: - 

 Software: Sets of instructions that govern the operation of computers can make the hardware  

                               run. 

 Hardware: All the physical components of a computer system.  

 System software: Software that controls the overall internal operations of a computer. 

 Operating system: A system software that acts as an interface between the user and the 

                                                  computer hardware. 

 Utility: Software responsible for the smooth functioning of a computer system. 

 Application software: A software that fulfils user needs to perform specific tasks. 

                           EXERCISE CORNER 

        A. Tick the correct answers. Cross-check your answers with your classmate: 

                   1. G.S. InfoTech is an educational company. It uses a computerized attendance system. 

                              Which type of software is it? 

      a) General-purpose software         b) System software    c) Tailor-made software 

 

2. Which of the following is not a version of windows? 

       a) Windows 10                                                b) Kit Kat            c) Windows 8 

 

                   3. Which of the following is not an operating system? 

        a) Windows                                                     b) Android                    c) CS6 

 

4. Which of the following is not general-purpose application software? 

        a) Excel                                                             b) Word                       c) Payroll system 

 

5. Which of the following utility scans for computer viruses and cleans them? 

        a) Disk defragmenter                                    b) disk cleanup          c) Antivirus 

 

B. Fill in the blanks. 

 

 
Tailor-made     operating system       software      software 

suite           utility 



 

1. Computer is able to do nothing until it is instructed by the software. 

2. A utility software help in smooth functioning of computer system. 

3. A collection of related software that are bundled and sold together is called a  

            software suite. 

4. A customized software is also called tailor-made software. 

                     5. A/An operating system acts an interface between the user and the computer hardware. 

C. State ‘True’ or ‘False’: - 

                      1. General-purpose application software are developed for the mass market                True 

 

                      2. System software is not necessary for computer system.                                                False 

                      3.Application software are installed on the computer as per the user requirement.      True 

                       4. Utilities improve the functionality of a computer system.                                            True 

  5. MS Office is a software suite.                                                                                          True 

D. Match the columns. 

            Column A                                                        Column B 

1.                                                                  a. Word processing software       

 

2.                                                                  b. Multimedia software 

 

3 .                                                                 c. Spreadsheet software 

 

4.                                                                  d. Presentation software 

 

5.                                                                  e. Graphics software 

 

                 E. Short answers questions: 

                   1. What is software?  

                           The set of instructions that govern the operations of a computer system and make the  

       hardware perform is called a software. 

 

                   2. Draw software hierarchy to represent different types of software.  

 

 

 

 5 

 4 

1 

2 

3 



 

          

                   3. Give any two examples of system software. 

                         a. Operating System               b. Utility Software 

                   4. Name any two desktop operating systems. 

                         a. Windows                            b. Linux 

                  5. Write names for any four-application software. 

                         a. MS Office        b. Adobe Photoshop   c. Windows Media Player   d. MS Paint 

 

F. Long answer questions. 

               1.Why is system software require?  

                    System software controls overall internal operations of a computer system. In general, 

itprovides a platform for running application software. It manages all the hardware 

components those are attached  to the computer system. 

              2. What is a software suite? Give any two examples of software suites. 

                       A collection of related software or packages that are bundled and sold together is called a 

software suits. 

                    Examples:    1. MS Office and Open Office      2. CS6 

              3. What is an operating system? 

                   An operating system is the first program that gets loaded into computer’s 

                        memory when a computer starts. It acts as an interface between the user and the hardware. 

              4. Describe the term application software. 

                      Application software is a set of programs written by the programmers in order toperform    

specific types of tasks on computer such as creating a document or presentation, doing 

calculations, preparing medical reports, booking tickets etc. 

             5. Distinguish between system software and application software. 

        

                  

 

 

                      System Software                   Application Software 

System software controls overall 

internal operations of a computer 

system. 

Application software is a set of 

programs written by the programmers 

in order to perform specific types of 

tasks on computer 

Example: Operating system, utility 

software 

Example: MS Office, Desktop Publishing 

software 



 

 

6. Distinguish between general-purpose and tailor-made software. 

               

 

 

 

              7. What is utility software? 

                Utility software is a type of system software. It performs specific tasks related to  

                            managing a computer, its device or its programs. A few tasks are take backups,  

r                     ecover data, and avoid virus  attacks. Utilities also help to ensure smooth  

                            functioning of a computer system. 

 

 

     BRAIN TEASER 

 The following are different software categories. Write two software names  

 for each. 

 

1. Word processing software                                      Microsoft Word, Microsoft WordPad 

2. Desktop publishing software                                          CorelDraw, Page maker 

3. Operating system                                                                   Windows, Linux 

4. Utility                                                                                   Antivirus, Disk Cleaner 

5. Multimedia software                                                      Flash, Windows Media Player 

 

 

                General Purpose           Software Tailor-made Software 

General purpose software is 

designed to fulfill the general needs 

of people. 

Tailor-made software is designed to 

fulfill the specific needs of any user or 

organization. 

Example: MS Word, MS Excel Example: Tally 



 

WORKSHEET - 1 

A. Identify the following electronic components. Also, write the generation in which they were used. 

 

 

 

                     Component: 

                  1. Vaccum Tubes                    2. Transistors                   3. Integrate Circuits 

           Generation: 

                  1.First                                      2. Second                                 3. Third  

             B. Write names of any four operating systems. 

        1. Apple macOS                                2.Microsoft Windows 

        3.Google's Android OS                     4.Linux Operating System 

             C. Write names of any four-application software? 

                      1.MS Paint                                         2. Microsoft Office 

                      3.Coreldraw                                      4. Windows Media Player 

.          D. Give names of any two tailors-made software? 

                      1.Tally                                                2. Payroll 

             E. Give names of any two processing applications? 

                     1. Microsoft Wordpad                       2. Microsoft Word  

             F. Distinguish between system software an application software? 

 

                SYSTEM SOFTWARE                 APPLICATION SOFTWARE 

1.System software controls overall  

     Internal operations of a computer  

     System. 

 

Examples: Operating system, Utility 

software 

1.Application software is a set of 

programmers in order to perform 

specific types of Tasks on computer. 

 

Examples: MSOffice, Desktop   Publishing 

Software 

 
 

 



 

 
CH-3 

MANAGING WINDOWS, FILES AND FOLDERS 

 Keywords: 

1. Windows: An operating system developed by Microsoft. 

2. Window : A rectangular box in which a file, folder or application is displayed. 

3. Task view: A viewing mode that shows multiple opened windows and allows to 

                            switch among them quickly and easily. 

4. File explorer: A tool of Windows operating system that allows you to create  

                            and manage files and folders. 

 

EXERCISE 

       A. Tick the correct answers. Cross-check your answers with your classmate: 

            1. A separate viewing area on the computer that displays its contents is called: 

                  a. Windows                      b. Window                       c. Desktop 

            2. Which of the following enlarges a window up to its standard size? 

                    a. Maximize                    b. Enlarge                        c. Minimize 

             3. Cascading windows are also called: 

                    a. Overlaid windows       b. Overlap windows       c. Overflow windows 

              4. To open the file explorer, click ____________________ 

                      a. Start  Windows System  File Explorer 

                      b. File Explorer  Start 

                      c. Start  All apps  File Explorer 

             5. Which of the following can hold files, application and subfolders?  

                        a. File                                  b. Application                      c. Folder 



 

            B. Fill in the blanks: 

 

 

                  1. A  file is an object that contains information in it. 

                  2. The  recycle bin holds deleted files and folders. 

                  3. The  F2 is a keyboard shortcut to rename a file. 

                   4. A folder within a folder is called a  subfolder. 

                   5. The Alt + F4 is a keyboard shortcut to close a window. 

              C. State ‘True’ or ‘False’. 

                   1. The permanently deleted files cannot be recovered.                                      True                 

                   2. The ‘Move to’ option allows you to move selected files or folders.               True 

                   3. A folder can contain only two subfolders and files.                                        False 

                   4. A file must have an extension.                                                                           True 

                   5. On pressing shift key, you can select adjacent folders.                                   True 

            D. Match the columns: 

                         Column A                                            Column B 

                   1. CTRL + Shift +N                                        a. To cut an item                                       (5) 

                   2. Shift + Delete                                               b. To copy an item                                    (4) 

                   3. Alt+ F4                                                         c. To create a new folder                          (1) 

                   4. CTRL+C                                                      d. To delete selected items permanently (2) 

                   5. CTRL + X                                                    e. To close the current window                (3) 

           E. Short answer questions. 

              1. What is a window? 

                A separate viewing area that displays its contents. 

              2. What are the window control buttons? 

               Maximize,    Minimize,        Close. 

Subfolder          ALT+ F4           F2            file           Recycle 

bin 



 

             3. What is a file or folder? 

             File: A file is an item than contains information in it.  

                   Folder: A folder is a virtual location or storage for files, applications and otherfolders. 

 

            4. How do you cascade windows? 

               Right-click the taskbar -->A context menu will appear --> Click cascade windows option --> Your 

window will cascaded. 

            5. What would you do to view the desktop completely, if multiple windows are opened? 

              Right-click taskbar --> Click show the desktop 

            6. How do you rename a file? 

             Open file explorer locate your file --> select Home tab --> Click Rename options 

         F. Long answer questions: 

              1. Describe the File Explorer. How do you create a folder using the File Explorer?  

                     Write steps. 

                 File Explorer --It is a tool that allows you to create and manage files and folders on computer. 

                       Steps to create a file using File Explorer: 

a. Open the file explorer and click on drive or folder where you want to create a new file.  

b. Select Home tab.  

c. Click drop down arrow of New Item option.  

d. Select an application whose file is to be created.  

e. Type in new name for created file. 

2. What is Recycle bin? How do you move files or folders to the recycle bin? 

Recycle Bin is a folder or directory where deleted items are temporarily stored. Items placed 

    in the recycle bin can be recovered from there. If files or folder are deleted from Recycle Bin,  

          then these cannot be recovered. 

     Steps to move files or folder in Recycle Bin:  

     1. Select the unwanted file in explorer window.  

     2. Click the delete option in Home tab. 

 

3. Write the steps to move a folder from D: drive to E: drive. 

                      Steps to move a folder from D-drive to E-drive:  



 

                   1. Open file explorer. 

                   2. Locate and select folder which you want to move from D drive.  

                   3. Click the ‘Move to’ option in Home tab.  

                   4. Click on choose location option from the drop-down menu.       

                   5. ‘Move Items’ dialog box appears. Choose a new location where selected items are to be      

moved.  

                   6. Click Move button. The selected files or folder will be moved. 

 

BRAIN TEASER 

 Write the options to perform the following tasks using the File Explorer:- 

1. Create a new folder: click Home                         New 

  2. Move a selected folder: click Home                    Move to 

  3. Copy a folder: click Home                                  Copy to 

  4. Delete a folder: click Home                                 Delete 

  5. Rename a folder: click Home                              Rename 

 

 

 

 

 

  

 

 

 

 

                                               



 

                                                                      CH-4  

        FORMATTING AND PRINTING  WORD DOCUMENTS 

 Keywords: 

                 1. Word processor: An application that performs the tasks of composing, editing, formatting  

                                 and printing of documents.                                  

                 2. Formatting: It refers to changing appearance of text and layout of a  

                           document. 

                 3. Alignment: It refers to the placement of text. 

                 4. Page orientation: It is the direction in which a document is displayed or printed. 

              

                                      EXERCISE 

          A. Tick the correct answers. Cross-check your answers with your classmate: 

              1. In which group of the Home tab are the features Bold, Italic and Underline present? 

   a. Font group of the Home tab 

   b. Paragraph group of the Home tab  

   c. Clipboard group of the Home tab 

 2. Which of the following opens up when you click the dialog launcher arrow of the font group?   

   a. Font dialog box             b. Paragraph dialog box         c. Proofing dialog box 

     3. To add border to a page, you will click: 

  a. Page Layout Page borders                       b. Design  Page borders 

                         c. Insert  Page borders 

                 4. In which group of the Home tab is the Shading option present? 

          a. Font                           b. Paragraph                     c. Styles 

        B. Fill in the blanks: 

      

 

 1. Microsoft Word is a popular     word processor    . 

Alignment          Font         page margins       mini         word 

processor 

 



 

 2. Bold button is present in the     font      group of the Home tab. 

 3. A bar appears when you select the text in word document. It is called    mini    . 

 4. The term       alignment       refers to the placement of text. 

                          5. The blank spaces around the edges of a page are called       page margin       . 

             C. State ‘True’ or ‘False’:  

                       1. It is not possible to change the size of text in Word.                                         False 

                       2. You cannot apply italic and underlined effect if a text is bold already.         False 

                       3. Font dialog box holds almost all the text formatting options.                         True 

                       4. Numbering list is used to create an unordered list.                                          False 

                       5. A border is used for highlighting a paragraph, text or document.                True 

              D. Short answer questions: 

              E. Long answer questions: 

                     1. Write the steps to change existing font of selected text into Arial. 

                         Steps to change existing font to Arial font: 

                                 i. Select the text which you want to change. 

                                 ii. Click the Font drop down arrow. 

                                 iii. Choose the Arial Font. 

                     2. Distinguish between Bullets and Numbering lists. How do you create a bulleted list?           

                      A bulleted list is used to create an unordered list, where no sequence of items is required. 

                           Numbering list is used to create an ordered list.  Steps: 

                                   i. Click Home tab  

                                 ii. Bullets or Numbering drop down arrow in paragraph group. 

                                 iii. Select a bullet or numbering style.  

                                 iv. Type the item and press Enter to include next item in the list. 

                     3. Write the steps to add a border around a document page. 

                    Steps to add a border: 



 
                             i. Select the text or paragraph.  

                             ii. Click Home tab 

                             iii. Select drop down arrow of Borders option in Paragraph group.  

                             iv. Select the Borders and Shading option.  

                             v. Then, choose the border for the document. 

                             vi. Click OK. 

                     4. How do you set page margins of a document from Normal to Narrow? Give steps. 

 Steps to set page margins of a document from Normal to Narrow are as follows:  

 i. Open the document.  

ii. Click the Page Layout 

                        iii. Select drop down arrow of Margins in Page Setup group. A drop-down list of margin   

       appears.  

iv. Select Narrow margin. 

BRAIN TEASER 

 Write the keyboard shortcuts for the following: - 

         ACTIVITY                       KEYBOARD SHORTCUT 

1.To open an existing document a. CTRL+ O 

2. To launch Font dialog box  b. CTRL + SHIFT + F 

3. To make text underline c. CTRL + U 

4. To apply justify alignment d. CTRL + F 

5. To print a document e. CTRL + P 



 

 

                WORKSHEET - 2  

A. Encircle the answer of following in the given maze: - 

 

 

      

B. The following are the steps to create a new folder: - 

    Arrange these steps in order by putting number 1 to 5.  

 

 

 

 

 

C. Write the use of following keyboard shortcuts:-  

1. Windows + E         To open the file explorer 

2. Shift + Delete         To delete selected files or folder permantely from a computer  

                                    System.   

 3. CTRL + SHIFT + N       To create a new folder on the desktop or at the given location.  

 4. CTRL + E                        To align the text in center        

 5. CTRL + P                    To Print a document                                 



 

                                                                                             CH-5  

    Working with styles and objects in word 

 Keywords: 

 1. Style set: A predefined set of formatting. 

 2. WordArt: A quick way to insert decorative text in a document. 

3. SmartArt: Ready-made graphics to represent information visually. 

                

                                          EXERCISE 

A. Tick (      )  the correct option. Cross-check your answers with your classmate.                

1.Which of the following tab contains styles? 

a. Insert                              b.Home                         c. Design 

  2. Which of the following is not a part of the illustrations group of the Insert tab? 

        a. Pictures                          b. Shapes                       c. Tables 

  3.Which of the following tab opens up on selecting a created shape? 

       a. Drawing Tools   Format  

       b. Picture Tools       Format 

       c. Smart Art Tools          Format 

   4. Which of the following is a keyboard shortcut to open Styles pane? 

       a. ALT + Ctrl+ Shift + S              b. ALT + S                   c. CTRL + S 

    5. Which of the following do you click to change the shapes of WordArt text? 

       a. Insert           WordArt             b. Format         Text Effects          Transform 

       c. Text Effects          Shadow 

B. Fill in the blanks. Compare your answers with your classmates’ answers: - 

            New Style              WordArt                Pictures             Online Pictures              Style 

1. You click styles dialoge launcher to open the Styles pane. 

2. The Newstyle  button in the Styles pane allows you to create a new style. 

3. WordArt is a quick way to insert decorated text in document. 



 

4. The online pictures option allows you to insert pictures from the computer hard disk. 

5. The pictures option is present in the illustrations group of the insert tab. 

               C. State ‘True’ or ‘False’ . 

                1. A style set is a predefined set of formatting.                                                             True 

                2. In Word, instead of using predefined styles, you can create your own styles.          True 

                3. In Word, you can directly add the text in the Smart Art graphics by clicking           True 

                     on [Text] holder. 

            

          D.   Short answer the following questions: -  

 

                    1. What is a Style set? 

                  Ans: - A style set is a predefined set of Formatting. It consists of font style, colour and size 

                                  that can   be applied to the text to change its appearance quicky.  

                   2. State the use of WordArt feature? 

                   Ans: - WordArt is a quick way to insert decorative text in the document.    

                   3.  Which tab allows you to edit and format WordArt?    

                   Ans: - Insert      

                   4. What is SmartArt? 

                     Ans: - SmartArt feature contains various graphics that allow you to represent  

                                           information visually. 

                     5. In which tab is Picture option available? 

                   Ans: - Insert   

                                                                 BRAIN TEASER 

 Identify the following groups: - 

 

 

 

                                    

Styles                                                  Word Art Styles 
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